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DVD Assets

The files you need
are on your DVD
in the folder called Aly
Fell in the Workshops
section.
SOFTWARE: Photoshop
CS3 (demo)

®

Aly Fell creates a vintage horror pulp
fiction cover in the style of EC Comics

cience fiction comics, pulp
fiction and horror have always
appealed to me. Growing up in
the 70s reading comics such as
Nightmare and Psycho and watching
Christopher Lee flashing his teeth as
Dracula gave me a taste for the macabre.
When I got the desire to recreate the
mood and feel of these wonderful stories
that dominated newsstands from the 30s
though to the 60s and 70s, I found I could

do it easily with Photoshop. Here I'll take
you through my process. [ won't be
concentrating on the technique as much
as explaining the choices you make when
choosing text, colour and mood, because
these comics were all about mood.

A good idea before starting something
like this is to look around the internet for
comics and covers that inspire you.
Creating a convincing look for something
like this requires a degree of research into

In depth Drawn of the dead
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your inspiration, and an understanding of
what the covers were trying to achieve. I'll
start with the basic production of the
image for the cover, from sketching
through to final image.

Then I'll show the techniques for
ageing and presenting the finished cover
as a complete image. This is a dark and
scary workshop, so only continue if you're
prepared to find out what made that
scraping noise in the attic...

Getting started

I normally start with a few
thumbnails, but in this case I had an idea
of what I wanted to do from the
beginning, so I sketched the rough out
straight away. I create a new document in
Photoshop, usually A4 at 150DPI. It's easy
to upsize later to 300DPI doing this, as
you just double it. If the composition
seems to be growing as you draw, you can
always stretch it out using the Crop tool.
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Sketching

I rough out using the Conte Pencil
in Photoshop with Shape Dynamics on,
as this gives you some nice, sketchy
‘thicks and thins’. I'm going for a fairly
straight-on composition, with a simple
background. The covers of old detective
novels used to concentrate on the
figures and lighting for feel, and kept the
background simple, as text would usually
cover much of it.

Initial colouring

My first colouring is often fairly
messy! I create a new level and set the
layer mode to Multiply. I don't worry
about detailing yet, just where [ want the
light sources and how I want colour to set
the mood. I use a custom brush to blob
in colour, which is easy to make: Hard
Round, with Spacing set to 10, Wet Edges
on, and a Dual Brush option with a heavy
texture such as Plastic Wrap Light. »
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Body colour

From here on it’s a basic process
of building up the colour. I work my
image up by starting with the faces and
working out from there, painting skin
and textural information to build up tone
and shading. It's better to work out of
dark into light, with the final painting
stage being highlights. Because I'm after
a fairly cartoony image, my detailing
will be very selective; concentrating on
faces and accessories, leaving brushmarks
to provide a suggestion of detail in the
other areas.

Flip the image

A good tip to make sure there are
no glaring errors in the drawing/painting
process is to constantly flip the image,
giving you a new perspective on how
you are working. ['ve set up a personal
shortcut for this which you can do
yourself in the Keyboard Shortcuts in
the Edit menu. This way I can flip as
part of my work flow and it becomes
intuitive as I work, constantly switching
back and forth. It also eases brush making
when working against your natural left-
or right-handedness.
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Flatten the layers

At some point, I flatten the layers —
usually after I've laid down the body
colour to avoid focusing too much on the
original drawing, but this is personal
preference. You can carry on making
decisions on new layers - if they work,
flatten them. This keeps the working file
size down too, and speeds up Photoshop.

Changing your mind

As the image develops, certain
things don't always work. Don't be afraid
to change your mind. For example, the
axe in the sketch was hanging at the
zombie’s side. I decided to bring it up to
head height, giving him more intent. I
brought out the girl’s hand holding the
zombie’s finger to make it clearer what
she was doing. I lassoed the original hand
then cut and pasted it into a new position.

Character design

Deciding how your characters will
look can date them specifically. If you're
setting them in the 60s, make sure they at
least have a 60s look: researching outfits
can be very important. The zombie wears
a generic shirt and trousers so could fit
almost anywhere, but the girl’s clothes
and hair are essential to the period. She’s
dressed in a pencil skirt and tight blouse
that put her in the right time.

Highlighting

Particularly with the zombie,
highlighting is very important. I want
him to look rotten and glistening. With
the main colour on him fairly subdued
with desaturated tones, it's satisfying to
select a hard-edged brush with Shape
Dynamics on and add highlights. A dab
of bright colour on areas such as the
eyeballs and guts makes them appear wet.

Enlarging
images

The Crop tool isn’t just
there for making the
canvas smaller. Drag
the Crop tool over the
whole image, and using
the little boxes on the
sides and corners you
can stretch the canvas
out to a larger desired
size. Make sure your
background colour is
what you want, or
matches your existing
one, otherwise you’ll be
undoing it straight away!

Transform
ctrl/Cmd+T
Need to adjust the size or
\ shapeofa selection? This

L\ takes you straight to the

A\ option to do so!

Shadow

1 often leave my final lighting till
the end. If, like me, you end up always
working a little toward lighter rather than
dark, a good way to achieve dark shadows
and moodiness is to flatten the image and
duplicate the layer. Set the top one to
Multiply and desaturate it a little. The
whole thing will now look too dark.
Select the Eraser with a fairly soft-edged
brush and maybe a Dual Brush option for
a bit of texture (once again Plastic Wrap or

a similar brush will do for this), and start
* to erase the areas you wish to stand out

from the shadow. The characters will start
to appear out of the darkness and you can
control the areas of shadow with the
pressure you apply.
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Texture overlay

Before I finish this section, I
want a bit of texture on the walls to break
up some of the flatness of the colour.
What I use is a personal texture that's
basically a photograph of damaged
plaster with a green hue, broken with
white. I drag this over my image and
stretch it to cover the whole area. Set this
layer to Overlay at about 55 per cent
Opacity. I erase the areas I don't want to
have texture on, in this case leaving the
walls. It breaks up the colour and gives
more depth to the image. Texture overlay
is fun and can bring some interesting
results, but shouldn't really be overused
as it can distracting, and is only there to
enhance your existing mark-making.

Upsize image

As I said earlier, I tend to start
working on an image at a relatively low
resolution, so before I start adding text
and graphics, I enlarge the image by
about 50 per cent purely to add a few
details and tighten up some of the edges
that could look a bit blurry at a lower
resolution. With a flat image it's now time
to start adding the final touches.
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Choosing text
One of the most important parts of
a comic’s cover is the text. Strong dynamic
typefaces, often totally bespoke to the
cover, are integral to the final look.
Horror comics usually use fonts that are
‘alive’ with dripping blood and bold
colour. A quick search for free horror fonts
on the internet will bring back a copious
choice, and I've selected a couple, Creeper
and Wet Paint, from a website called
http://simplythebest.net/fonts/horror_
fonts.html. I'll use these with old
favourites like Abadi MT Condensed,
which is sans serif and easy to read.

I decide to emulate the EC look and
have about a third of the image devoted
to the text, which is usually on a coloured
background. I cut and paste my image
about a third down the canvas and on a
new level fill in the empty area with a
mute burgundy colour, and at the side a
cream strip for the vertical text. I select
Creeper as the main font for TOMB’ and
'HORROR' and Wet Paint as the
secondary one for “TALES of the...
“TOMB' is set to 190 points, and I scale
"TALES of the’ using the Transform tool.

I put a drop shadow on TOMB and start
on the logo for Awesome Fear Comics.
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ctrl/Cmd+U
A useful shortcut for

adjusting the saturation,
hue and lightness of any
selected area.

/

Using paths

To get the logo text to go round the
central circle, I use Paths. Firstly, bring up
¢ the Paths window from the dropdown
menu. Using the Elliptical Marquee tool
and holding down Shift, select a circle. In
the Paths window create a new path and
make it a ‘work path’. Select the Type tool
and click on the edge of the circle. The
text cursor appears and all text you type
will follow the edge of the circle. When
you've done this, click Commit Edit, and
you can now Transform this to fit. »
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LOVER COME BACK!

He died yet lived

Final text

Once I've completed the graphical
elements on the title area, including the
text, [ merge these layers, making sure the
main image of the characters is still
separate and underneath. I can then erase
the area where I want the top of the
zombie’s head to go over in to the title
area; a common feature of comic covers.
Now those layers have been merged
I can erase the drop shadow, a vector
element, with no problems.

However, I still need to produce the
title of the story, a strapline and invent a
fictional author for it. Once I've decided
on these elements it’s a case of choosing
a typeface and where they’ll sit in the
composition, which really decides itself
with the darker area at the base of the
image. When I've positioned these, I
flatten the image.
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Ageing

To age the cover, create a duplicate
layer of the image so you have two the
same. Fill the bottom one, the
background, with white, and make the
canvas fractionally larger than the
painted area. You should now have a
white border to the image. On the top
layer, choose Select>Load Selection. Old
worn paper has a cream faded look, so

PRO
SECRETS
Transforming
text

Once you’ve typed
your text you can scale
it and transform it with
the Transform tool and
it’s still editable as text.
Only when you rasterise
the type (Layer>
Rasterise>Type)

can you no longer
change what you’ve
written. Rasterising
essentially converts
vector-based artwork,
such as text and layer
effects, into pixels that
you can edit.

make sure your background colour is set
accordingly, and using a heavily textured

eraser brush, (hard round with a texture
such as Plastic Wrap), start to gently erase
the edges of the image, occasionally
cutting in a bit as though the paper’s torn.

ImagitieX September 2007

UNI21.tut_pulp 74 @

Creased up

Add more creases along the binding
side as this is where any comic gets its
main beating, and perhaps a fold or two
on the corners. This requires a degree of
research, so look at how old comics crease.
The final tweak to ageing is a decent
texture overlay with random marks,
stains, folds and tears. Using one I've
adapted from various sources, I enlarge it
to fit the canvas and set it to Overlay in the
layer modes and take the Opacity to about
60 per cent, erasing certain areas to give a
randomness to the marks. Finally, I flatten
the image, reduce the saturation a little
and the picture’s done. @

LOVER COME BACK!)
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